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TML BASIC™ LICENSE AGREEMENT

This manual and the software described in it were developed and copyrighted by
TML Systems, Inc. and are licensed to you on a non-exclusive, non-transferable basis.
Neither the manual nor the software may be copied in whole or in part except as
follows:

1. You may make backup copies of the software only for your personal use
providing the backup copies bear TML Systems' copyright notice.

2. You have the right to include the object code provided in the several libraries
included with TML BASIC in programs you develop using this software and you
also have the right to use, distribute and license such programs to third parties
without payment of any further license fees providing that you include the
following copyright notice (no less prominently than your own copyright notice)
in the software and its documentation:

"© 1987 TML Systems, Inc. Certain portions of this software are copyrighted by
TML Systems, Inc."

3. You may not, in any event, distribute any of the source files or the TML BASIC
application provided as part of this software.

4. You may use the software and its documentation at any number of locations or
on any machine so long as there is no possibility of it being used at more than
one location or on one machine at any one particular time.



CUSTOMER SUPPORT AND PRODUCT UPGRADE PLAN

Software Registration. Your registration of TML BASIC is ESSENTIAL for you to
receive the full benefits of TML Systems' customer services. TML BASIC is a very
large and sophisticated software package. From time to time, TML Systems will
improve its product making it even more powerful and useful to you. You can take
advantage of our ongoing development efforts if you have returned your
registration card to us. As a registered TML BASIC user, you will receive
announcements about major improvements for your software. These
announcements will provide you the cost of the upgrade and ordering procedures.
Only registered users will receive these upgrade notices and be eligible to purchase
the upgrade.

Technical Support. We at TML Systems would like you to take the greatest
advantage of your development tools as possible. If you have a technical problem we
will be glad to help. Gather ALL pertinent information to recreate the problem along
with your registration number, and call our Technical Support Department at (904)
636-0118 during our normal support hours. You may also write to:

TML Systems, Inc.

Technical Support Department
8837-B Goodbys Executive Drive
Jacksonville, Florida 32217

Remember, it is required that you include your registration number with all
correspondence and have it available when you call TML Systems. TML Systems
retains the right to deny Technical Assistance to any person unable to identify his
software by registration number.
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Inirecuciion

Welcome to TML BASIC for the Apple 1IGS. TML BASIC is a programming
language designed to meet the needs of the broadest range of programmers possible
for the Apple IIGS. TML BASIC is a modern, 16-bit, compiled implementation of the
BASIC (Beginner's All-purpose Symbolic Instruction Code) language and is
compatible with Apple Computer's GS BASIC, an interpreted implementation of
the BASIC language.

TML BASIC is an extended version of the BASIC programming language and
includes many new features and statements not found in more traditional
implementations. For example, TML BASIC provides control structures like the
DO...WHILE...UNTIL loop and block IF statements, the PRINT USING statement,
user defined, multiline functions and procedures with local variables, and a
mechanism for supporting separately compiled libraries of code.

Programmers familiar with AppleSoft BASIC will find TML BASIC an easier and
more powerful means of developing programs to run on the Apple IIGS. Using the
TML BASIC Translator (a separate product), AppleSoft BASIC programmers are
capable of converting their AppleSoft BASIC programs into TML BASIC programs
for increased performance and easier maintainability on the Apple IIGS.

TML BASIC is a complete programming environment which combines a compiler
with a fully integrated, mouse-based, multi-window editor. Remember, TML
BASIC is a compiled BASIC language. Results of a compiled language are faster and
more efficient programs capable of being created and tested in TML BASIC's
user-friendly environment.

TML BASIC has been designed specifically to take advantage of, and provide access
to, the new features and capabilities of the Apple IIGS. TML BASIC runs in a full
16-bit native mode under ProDOS 16. Complete access to every Apple IIGS Toolbox
routine, including Super HiRes graphics, Menus, Windows, etc., are provided with
BASIC procedures and functions. With TML BASIC, you will be able to develop
stand-alone ProDOS 16 applications capable of running independently of TML
BASIC and transferable to any Apple IIGS disk.

In addition to writing programs which take advantage of the Apple IIGS Toolbox,
TML BASIC allows you to write more traditional programs which use only the text
screen. We call these textbook programs. Textbook programs are the type of
programs you would enter directly from BASIC textbook examples and then
compile them. An understanding of the IIGS Toolbox is not necessary to write a
textbook program.

TML BASIC User's Guide 1 Infroduction



About this Manual

No specific knowledge of programming the Apple IIGS is necessary to use TML
BASIC, however we do assume you are familiar with the concept of programming
and perhaps have had some experience programming on another machine.

The TML BASIC manual is divided into four major parts. The first part of the
manual is a user's guide, and its chapters discuss how to actually operate TML
BASIC and write your first program. A complete TML BASIC language reference is
provided in the second part, and the third part provides documentation on how to
program using the Apple IIGS Toolbox. Finally, the fourth part is a collection of
appendices. This manual assumes you are familiar with the Apple IIGS Finder and
the machine itself.

The following paragraphs outline the information contained in each of the
manual's chapters. Use these descriptions to find the information you are looking
for.

Part I: TML BASIC User's Guide

TML Systems recommends you take the time to study Chapters 1 through 6 prior to
beginning your actual programming work. Chapters 1 - 4 and 6 explain in detail the
capabilities of the product itself, while Chapter 5 instructs you through your first
program. These chapters are certain to prove useful to the programmer who has
taken the time to master them. Each chapter reminds you to close all example
programs opened during the chapter's discussion and to exit TML BASIC, thus
assuring each chapter is treated as an independent learning session of TML BASIC's
integrated environment.

Chapter 1:  Starting out with TML BASIC shows you how to make a backup copy of
TML BASIC, discusses what files are on the TML BASIC distribution
disk, explains the differences between Textbook and Toolbox
programming and provides a comparison of compiled versus
interpreted languages.

Chapter2:  Using TML BASIC includes a quick tour of TML BASIC using two
example programs included on the TML BASIC distribution disk.
The chapter's discussion takes you from the first step of running TML
BASIC to performing window manipulation commands.

Chapter3: Compiling and Running a Program discusses TML BASIC's
compile features while showing you how easy it is to run a TML
BASIC program. Creating libraries as well as detecting and correcting
errors in your program's source code is also discussed.

TML BASIC User's Guide 2 Introduction



Chapter 4: Advanced Program Editing discusses some of the more powerful
features of TML BASIC's integrated editor, thus enabling you to use
TML BASIC more effectively in creating your own programs.

Chapter 5:  Your First Program explains the idea of textbook programming and
begins to introduce some of TML BASIC's language features by
instructing you through your first TML BASIC program.

Chapter 6:  TML BASIC Menu Reference provides a summary of TML BASIC's
menus and commands. This chapter should be used as a reference to
the features available within TML BASIC.

Part ll: TML BASIC Language Reference

The TML BASIC Language Reference is a complete reference for the TML BASIC
programming language. The first three chapters discuss various components of the
language, while Chapter 10 provides a thorough discussion of each statement and
function available in TML BASIC.

Chapter 7. Language Elements discusses the fundamental components which
make up a TML BASIC program. A discussion of constants, variables,
arrays and expressions is also included.

Chapter 8: Subroutines, Procedures, Functions and Libraries reviews the
language constructs available in TML BASIC which promote
modular programming for better organization of a program's code.

Chapter 9:  Files provides a review of the techniques and operations available in
TML BASIC for reading, writing and manipulating files.

Chapter 10: Statements and Functions is a comprehensive discussion of each
statement and built-in function implemented in TML BASIC. You
will find this chapter most useful during your programming efforts.

Part lll: Toolbox Programming

This portion of the manual is written for experienced programmers and introduces
the concept of programming the Apple 1IGS Toolbox. The Toolbox is the huge
collection of procedures and functions available with every Apple IIGS which
implements features like the Super Hi-Res graphics screen, Menus, Windows,
Dialogs, Sound, etc. Toolbox programming is not for everybody. Obviously more
complicated than textbook programming, Toolbox programming provides a whole
new spectrum of features you can add to your programs.
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Chapter 11:

Chapter 12:

Chapter 13:

Programming the Toolbox first reviews the contents of the Toolbox
and then introduces the language features available in TML BASIC
for accessing the Toolbox.

QuickDraw Graphics is the graphics engine for the Apple IIGS
which implements all of the drawing operations available for the
Super Hi-Res graphics screen. Because QuickDraw is the soul of the
Apple IIGs, this chapter provides a discussion and review of the
principles behind this powerful graphics engine.

Creating a Desktop Application discusses the techniques for
writing programs in TML BASIC which make use of the Desktop
metaphor. The desktop is considered the menu bar, a collection of
windows, dialogs, etc.

Part IV: Appendices

This part of the manual provides a wide collection of useful information for the
TML BASIC programmer. Included is a summary of the error messages generated
by both the TML BASIC compiler and editor. Also included is a complete list of
every Apple IIGs Toolbox routine accessible with TML BASIC.

Appendix A:

Appendix B:

Appendix C:

Appendix D:

Appendix E:
Appendix F:

Index

Error Messages provides a list of every error generated by the TML
BASIC editor, compiler, linker and runtime debugger. Along with
each error message is a discussion of what the error message means
and how it might have occurred.

Metastatements describes each of the TML BASIC compiler's
metastatements. Metastatements direct the compiler to behave in a
specific manner.

Apple lics Toolbox Libraries is a complete and exhaustive list of
every Toolbox procedure and function available with TML BASIC.

Comparing TML BASIC with GS BASIC is a summary of the
differences between the TML BASIC and GS BASIC languages.

The ASCII Character Set
ProDOS 16 Filetypes
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Apple lIGS Technical Documentation from Apple Computer, Inc.

While the Apple IIGS provides a new degree of friendliness to the user, the
programmer is confronted with the burden of developing software for a much more
sophisticated machine. Without the appropriate technical references, the task of
programming the Apple IIGS and its Toolbox will be nearly impossible. The
following paragraphs outline the technical documentation published by Apple
Computer for the Apple IIGS. Each of these texts is available directly from
Addison-Wesley or the Apple Programmer's and Developer's Association (APDA).

*  Technical Introduction to the Apple 1IGS is the first book in the suite of
technical manuals for the Apple IIGs. It describes all aspects of the Apple IIGS,
including its features, general design, and Toolbox.

*  Apple 1IGS Hardware Reference and Apple 1IGS Firmware Reference cover the
hardware details of the Apple IIGS. You will not necessarily need these texts in
order to develop applications for the Apple IIGS, however, reading them might
provide you with a better insight as to how the machine operates.

®  Programmer’s Introduction to the Apple I1IGS provides an excellent
introduction to the concepts and guidelines you will need to know in order to
develop quality applications which take specific advantage of the Apple IIGs.
While this text uses TML Pascal for examples, you will find the information
here useful for programming the Apple IIGS Toolbox with TML BASIC.

e Apple 1IGS Toolbox Reference: Volume 1 and Volume 2 is the complete and
authoritative reference for the Apple IIGS's built in set of routines which are
collectively known as the Toolbox. For example, the Toolbox contains the
software necessary to draw graphical objects on the screen (QuickDraw) and for
menus, windows, and sound. The Toolbox supports the Apple desktop user
interface and simplifies development of new and powerful applications.

If you intend to develop applications which take advantage of the Toolbox, you
will find these two volumes absolutely essential. It will be nearly impossible to
program the Toolbox effectively without this documentation.

*  Apple 1IGS ProDOS 16 Reference documents the operating system of the Apple
IIGs. The details of the System Loader and file manipulation operations are
covered in this text.

* Human Interface Guidelines: The Apple Desktop Interface. This book
documents Apple's standards for the desktop user interface to any program that
runs on an Apple IIGS or a Macintosh. If you are writing an application which
is to use the desktop user interface, you should study this manual to ensure
your application conforms to the standards set forth by Apple Computer.
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*  Apple Numerics Manual is the reference for the Standard Apple Numeric
Environment (SANE), a full implementation of the IEEE standard for
floating-point arithmetic.

In addition to these texts, Apple Computer publishes a series of Technical Notes for
the Apple IIGS on a periodic basis. These notes discuss often asked technical
questions and other mysteries about the Apple IIGS. The technical notes are
available on a subscription basis from the Apple Programmer's and Developer's
Association. Below is the address for the Apple Programmer's and Developer's
Association.

Apple Programmer's and Developer's Association
290 SW 43rd Street

Renton, WA 98055

(206) 251-6548

Please note that in order to purchase products from APDA you must first be a
member. There is a nominal annual fee required for membership into APDA.

Where to go for more Information

In addition to technical documentation from Apple Computer, you may find one or
more of the following texts useful in your programming efforts.

The following three books document the Apple IIGS Toolbox. While the books do
not use TML BASIC as examples, they still provide a wealth of useful information.
In particular, the Apple 1IGS Technical Reference by Michael Fischer provides

exhaustive coverage of the Toolbox, but in a much more readable fashion than
Apple Computer's Apple 1IGS Toolbox Reference volumes.

®  Apple 1IGS Technical Reference, Michael Fischer, Osborne/McGraw-Hill, 1987.

®  The Apple 1IGS Toolbox Revealed, Danny Goodman, Bantam Computer Books,
Prentice Hall Press, 1986.

*  Exploring the Apple 1IGS, Gary Little, Addison-Wesley, 1987.
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Notational Conventions

The following notational conventions are used in this manual. Understanding
these conventions will help make this manual more useful to you.

Notation_

Command

Source Code

Source Code and Important words

HELLOWORLD.BAS

TML BASIC User's Guide

Description

Bold typeface as shown in the left column
and appearing within the text of this
manual identifies commands you may
enter from the keyboard or by using the
mouse.

The typeface shown in the left column is
used to simulate the appearance of a
program's source code, or both input and
output, that would be printed on your
screen. This notation is used for program
listings as well as references made within
the text of this book to a particular source
code listing.

Certain words within the text of this
manual are italicized in order  to
emphasize their importance. Reference to
any portion of source code (i.e. variable
names) within the text of this manual also
appears in italics.

Words appearing in all upper case letters
represent program (file) names contained
either on the distribution disk or programs
(files) you create yourself. A filename with
the .BAS extension represents a program's
source code. A filename without the .BAS
extension represents a stand-alone
application found on disk.
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System Requirements

In order to use TML BASIC, you will need an Apple IIGS with at least one 3.5" 800K
floppy disk drive, and a memory expansion card with at least 256K bytes of
additional memory for a total of 512K RAM memory. For development of large
applications, TML BASIC can be used with a hard disk and up to 8 megabytes of
memory. TML BASIC supports the ImageWriter and any compatible serial printer
or any compatible parallel printer with an appropriate interface card.

Acknowledgements

TML BASIC™, TML BASIC Translator ™, TML Pascal™, TML Speech Toolkit™ and
TML Source Code Library™ are trademarks of TML Systems, Inc.

Apple®, Apple Computer, Inc.®, ImageWriter®, LaserWriter®, Mac®, MacWrite®
and ProDOS® are registered trademarks of Apple Computer, Inc.

Apple IIGs™, GS BASIC™, Finder™, Macintosh™ and SANE™ are trademarks of
Apple Computer, Inc.
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Starting Out with TML BASIC

Before you begin using TML BASIC, you should make a working copy of your
distribution disk and store the original in a safe place. This chapter explains how to
accomplish this task. It also describes the files on the TML BASIC distribution disk,
thus enabling you to see what files are provided and which of those files you will
need to use TML BASIC. A discussion of compiled versus interpreted languages is
provided, as well as the use of line numbers in TML BASIC.

Before proceeding any further, you should familiarize yourself with the Apple IIGS.
You should be knowledgeable in such tasks as booting your machine, using the
mouse, copying files, and selecting and running applications using the Apple IIGS
Finder. If you are unfamiliar with any of these operations, consult your Apple IIGS
Owner’s Manual and Apple IIGS System Disk User’s Guide for information.

Backing up the Distribution Disk

TML BASIC is distributed on one 3.5" 800K ProDOS 16 disk and includes the Apple
IIGs System Disk's files (version 3.1 or later). In the spirit of TML System's
philosophy - selling software without copy protection - the distribution disk is not
protected from being copied. Thus, you should make a backup copy of the
distribution disk and store the original in a safe place. This manual refers to the
backup copy of TML BASIC as the working copy. You should store the original TML
BASIC disk and use it in only in the event of your working copy being damaged.

Although TML BASIC may be copied, your license agreement specifically states you
may only do so for your own private use and only for the purpose of making a
backup copy. Any other copies are not allowed and are in violation of the United
States Copyright laws.

In order to make a backup copy, you will need an unused 3.5" disk and a disk
copying utility. Included with the Apple IIGS System files on the TML BASIC
distribution disk is the Apple IIGS Finder. The Finder includes the capability of
formatting an unused disk and copying the TML BASIC distribution disk's files onto
the newly formatted disk. Figure 1-1 illustrates the contents of the TML BASIC
distribution disk in an open window on the Apple IIGS desktop.

Refer to your Apple IIGS System Disk User’s Guide for information on how to use

the Finder, or your Apple 11GS Owner’s Guide for information about formatting and
copying to a disk.
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Figure 1-1
TML BASIC Distribution Disk

Files on the Distribution Disk

Table 1-1 lists the TML BASIC distribution disk's contents. The files shipped on the
distribution disk can be grouped into four categories: the TML BASIC compiler,
TML BASIC example programs, the Apple IIGS Toolbox libraries and the Apple IIGS
system files required to boot your machine and run TML BASIC or any applications
you might create.

Remember, not all the files included on the distribution disk are required to run
TML BASIC. In the following table, the files required to run TML BASIC are listed
in boldface, while the others are listed in normal typeface. The files listed below are
for the version 1.0 TML BASIC distribution disk. Subsequent releases of this
product may include different files.

Table 1-1
TML BASIC Distribution Disk Contents

/TML/ The name of the TML BASIC distribution disk.

TMLBASIC The TML BASIC compiler.
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TMLBASIC.OPTS

LIBRARIES/

PART1.EXAMPLES/

PART3.EXAMPLES/

MORE.EXAMPLES/

PRODOS

SYSTEM/

P16

START

LAUNCHER

FINDER

SYSTEM.SETUP/

TOOLS/

DESK.ACCS/
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This file saves various options for using TML BASIC such
as tab width, printer port, etc.

This folder (subdirectory) contains all of the library interface
file for the Apple IIGS Toolbox. These files are described in
detail in Chapter 11 and Appendix C.

This folder (subdirectory) contains the source code to the
example BASIC programs used in Part I of the TML BASIC
User Manual.

This folder (subdirectory) contains the source code to the
example BASIC programs used in Part III of the TML BASIC
User Manual.

This folder (subdirectory) contains the source code to the
several additional example BASIC programs which
demonstrate many of the capabilities of TML BASIC.

The ProDOS file that is used to begin the booting process of
your Apple IIGs.

A folder (subdirectory) containing the ProDOS 16 and Apple
IIGs system files necessary to use the Apple IIGS. This folder
contains only a subset of the files found on the complete
Apple IIGS System Disk necessary for TML BASIC.

The ProDOS 16 operating system.

A program which determines whether or not to run the
Program Launcher or the Apple IIGS Finder.

The Apple IIGS Program Launcher.
The Apple IIGS Finder.

A folder which contains any necessary boot time
initialization files for the Apple IIGS.

A folder which contains all of the RAM based Apple IIGS
Toolbox toolsets.

A folder which contains classic and new desk accessories.

This folder contains only the TML Clock new desk
accessory.
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DRIVERS/ A folder which contains the various printer and modem
drivers.

FONTS/ A folder which contains Apple IIGS font files. These files
are used by the Font Manager. This folder is empty on the
TML BASIC disk.

ICONS/ A folder which contains icon definition files. These files
are used by the Finder to display applications and
documents with their icons.

Textbook versus Toolbox Programming

The introduction of this book mentioned two different types of programs capable of
being written in TML BASIC. The first type is referred to as a textbook program and
represents the kind of program typically found in most BASIC programming
textbooks — traditional programs that use the computer's text screen. The second
type of program makes use of the special features and capabilities of the Apple IIGS
Toolbox.

Chapter 5 of this manual discusses textbook programming techniques and requires
all of the boldface files and directories listed in Table 1-1 be present on your working
copy of the TML BASIC distribution disk. In addition, you will need the
AVERAGES.BAS example program found in the PART1.EXAMPLES folder.

Part III of this manual introduces the concept of programming the Apple IIGS
Toolbox and describes the contents of the IIGS Toolbox. In addition to the boldface
filenames appearing in Table 1-1, programs designed to use the IIGS Toolbox will
require the files found in the folder LIBRARIES. You may also wish to have the files
in the folder PART3.EXAMPLES.

Setting Up

The following three sections describe how you might set up a working environment
for using TML BASIC with a single 3.5" 800K disk drive system, a dual disk drive
system using either two 3.5" 800K or one 3.5" 800K and one 5.25" disk drives, or a
hard disk.
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NOTE

As noted earlier, TML BASIC is shipped with the contents of the Apple IIGS System
Disk version 3.1, or later, and includes the Apple IIGS Finder. The Finder requires a
minimum of 512K RAM. On startup, System 3.1 identifies the amount of memory
available. If 512K or greater memory is available, the Finder is displayed. If only
256K RAM is available, neither the Finder nor TML BASIC will run. This manual
assumes your system includes at least 512K RAM and one 3.5" disk drive.

Single Disk Drive System

Users with a single 3.5" 800K floppy disk will find that TML BASIC can be used
exactly as it is shipped on the distribution disk without having to sacrifice any
functionality or performance. You should create a working single disk system by
making a copy of the distribution disk as described in the section Backing up the
Distribution Disk in the beginning of this chapter.

The only restriction imposed by the single disk system is the size of the programs
you develop will be restricted to available disk space to store them. On your
working copy of TML BASIC, feel free to delete the various folders containing
example programs. The PART1.EXAMPLES folder includes the example programs used
in the first part of this manual which you should keep on your disk if you intend to
follow the discussions in the next four chapters.

You will still have access to all example programs you choose to delete by copying
them from the original distribution disk as needed. Never delete any of the files
from the original distribution disk.

Two Disk Drive System

If you have a second disk drive, either another 3.5" 800K disk drive or 5.25" disk
drive (formatted for ProDOS 16 of course), then you can take advantage of this extra
storage capacity for developing larger programs. You may find it easier to keep all of
the example programs, as well as any new programs you create, on a separate disk
and access them using your second disk drive. The LIBRARIES folder (see Table 1-1)
should be kept on the TML BASIC disk, thus allowing the folder's files to be shared
by all programs.

Hard Disk Drive System
While a hard disk is not required to use TML BASIC, you will enjoy the luxury of
faster disk access and an extensive amount of disk storage space available for

creating large programs. To use any ProDOS 16 formatted hard disk drive with TML
BASIC simply copy the necessary TML BASIC files onto your hard disk as outlined
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in Table 1-1. If your hard disk contains Apple IIGS System files prior to version 3.1,
TML BASIC will not work. In this case, you should copy the System files from the
distribution disk onto your hard disk.

A Note on RAM Disks

Traditionally, Apple II users have found the use of RAM disks advantageous, and
have done so without "stealing" available memory from an application, due to the
Apple II's restriction of permitting only 128K of memory or less to a single
application.

TML BASIC and the Apple IIGS are different however. TML BASIC is a memory
resident application, so there is no advantage in storing TML BASIC on a RAM disk.
Further, TML BASIC maintains in memory, an entire copy of the file(s) it is editing;
inlcuding library files, compiled code, etc., and uses the Apple IIGS Memory Manager
to keep track of available memory. Thus, any RAM space you might allocate for a
RAM disk would only decrease the amount of memory TML BASIC has available to
it for editing and compiling.

Compiled versus Interpreted Languages

TML BASIC is a compiled language. In this regard, as well as others, it differs from
interpreted languages such as Apple Computer's GS BASIC. A programming
language is characterized by its collection of statements, expressions and other
components generally known as the syntax, or structure, of the language. While
programs written in a computer language are generally understandable to the
human reader, they are totally incomprehensible to the computer, or in the case of
the Apple IIGS, the 65816 microprocessor.

Before a statement written in a computer language can be executed by the computer,
it must first be translated into code understood by the computer - machine language.
Machine language consists of long lists of binary numbers (0's and 1's) that are
understood by the computer as a series of off and on states representing operations
the computer is capable of performing. Of course, a long string of 0's and 1's is not
easily understood or readily comprehended by humans.

A major part of any computer language system is its means of translating programs
into machine language. In an interpreted language, the translation is done while
the program is being executed, sometimes denoted as "on the fly". If a statement in
the program is executed 100 times, the translation is also done 100 times.
Interpreted languages run slower than compiled languages because of the need for
translation to occur during the running of the program.

With a compiled language, however, the translation of programs into machine
language is handled prior to running the program. Thus, each line in the program
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is translated only once - during the compilation process. In addition, the
compilation process discloses all of the syntax errors before the program is executed.
Of course, it can't find errors in the program's logic such as infinite loops. Compiled
programs run significantly faster than interpreted programs and they can also run
independently of any language processor. That is, compiled TML BASIC programs
can run by themselves under ProDOS 16 without TML BASIC on the disk.

Additionally, TML BASIC implements an integrated environment as a
memory-resident application that compiles programs with the same interactiveness
as an interpreter. This means that TML BASIC integrates its editor, compiler and the
running program into memory at the same time, thus eliminating the need to read
and write disk files which cause conventional compilers to be so much slower than
an interpreter in translating a BASIC program.

Line Numbers in TML BASIC

Historically, BASIC implementations have required the use of line numbers in
programs, however, TML BASIC does not require line numbers. In fact, TML
BASIC does not even allow the use of line numbers.

Interpretive BASIC language implementations require line numbers in their
program source codes so that the interpreter can locate statements and functions at
execution time that are not in sequential order. Line numbers are also used as a
fundamental component in an interpreter's editing process.

TML BASIC has no need for line numbers as it uses alphanumeric labels to locate
statements and functions in a program's source code. For example, rather than
entering GOTO 1000, in TML BASIC you would enter GOTO SetupProcess, where
SetupProcess is a alphanumeric label used to identify the SetupProcess routine. Use
of alphanumeric labels is illustrated in most of the example programs discussed in
Part III of this manual, as well as the example programs contained on the TML
BASIC distribution disk.
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Chepier 2
Using TML BASIC

In Chapter 1, you created a working copy of the TML BASIC distribution disk. Now
it's time to run TML BASIC and begin learning about some of the program's
capabilities. Before continuing, be certain you are using the working copy of TML
BASIC and you have stored the original TML BASIC distribution disk in a safe place.

In this chapter, you will learn about the steps necessary to invoke TML BASIC from
the Finder and how to perform file manipulation commands. Rather than creating
a new BASIC program to demonstrate these tasks, this chapter's discussion will use
example programs included within the PART1.EXAMPLES folder on your TML BASIC
working disk.

Running TML BASIC

Insert your working copy of TML BASIC into the 3.5" floppy disk drive and turn
(boot) the machine on. After the Apple IIGS completes its booting process you will
be presented with the Apple IIGS Finder's desktop. Figure 2-1 illustrates the
desktop's appearance after booting your Apple IIGs.

ok file Edit View Special Color
T N T T e T

B

THLBASIC ~ THLBASIC.OPTS  LIBRARIES
Y

L1EXAMPLES PART3.EXAMPLES MORE.EXAMPLES

PRODOS SYSTEM 1CONS

Figure 2-1
Apple IIGS Desktop
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The desktop will appear as shown in Figure 2-1 only if your working copy of TML
BASIC contains all of the files contained on the original TML BASIC distribution
disk, and if you booted your computer using that disk. The desktop's appearance
will differ if you are using some other hardware configuration (i.e. hard disk) or
arrangement of files on your working copy of TML BASIC.

Invoke TML BASIC by clicking the mouse once on the TML BASIC icon shown on
the desktop, pull-down the Finder's File menu and then select the Open command
(double-clicking the mouse over the TML BASIC icon accomplishes the same result
as selecting the Open command).

Opening the TML BASIC file results in a splash screen displaying the TML BASIC
logo. This splash screen tells you TML BASIC is loading into the Apple IIGS's
internal memory. Be patient, as the Apple IIGS requires a few moments before it
completes the loading process. Figure 2-2 illustrates TML BASIC's desktop (Main
Menu) after the program has been successfully loaded into memory.

Figure 2-2
TML BASIC's Main Menu

Examining the Integrated Environment

TML BASIC has been designed to take full advantage of the Apple 1IGS desktop
interface using the mouse, pull-down menus, windows, etc. This user-friendly
environment makes programming easy, as it integrates TML BASIC's editor and
compiler into the same working environment.
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The seven menus implemented in TML BASIC are designed to logically organize
the several commands available to you in TML BASIC. Using the mouse,
pull-down each menu to discover just how easy itis to use TML BASIC. Within
each menu, you will find the various TML BASIC commands. Most commands
found in the menus may be invoked by typing its corresponding command-key
equivalent rather than pulling down its menu and selecting the command with the
cursor. Command-key equivalents are displayed next to their command names in
each of the pull-down menus. Chapter 6 provides a review of each TML BASIC
menu, its corresponding commands and command-key equivalents.

Editing windows are the tools TML BASIC provides you for entering and modifying
program source code. TML BASIC allows you to have up to four different program
source codes open at one time. Each program is placed in a different editing window
and is independent of any other open windows. Only one editing window can be
active at a time. TML BASIC identifies the active window as the window which is
topmost. All commands issued by the user are performed on the source code
contained in the active window. Figure 2-3 illustrates the various components of a
typical TML BASIC editing window.

Close box Zoom box

' '

E[[==————-= A Window =—"——[]

gl <¢——— Title bar

<@———— \Vertical scroll bar

- Content >

|

<A

<4——— Grow box

Horizontal scroll bar

Figure 2-3
Editing Window Features

TML BASIC also implements dialog boxes as a means of communicating with the
user. The different dialog boxes used in TML BASIC will be discussed individually
as appropriate throughout the chapter discussions ahead. However, a brief mention
of what a dialog box is and how it works is discussed in the following paragraph.
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A dialog box is a window whose appearance is different than the editing windows
used in TML BASIC. Namely, it does not have a title across the top of the window,
nor does it have scroll bars and it can not be moved around on the screen. A dialog
box is used in TML BASIC to provide the user with requested information, or to ask
the user for required information before continuing. Dialog boxes usually inlcude
OK/Cancel buttons or Yes/No buttons. These buttons allow you to communicate
with TML BASIC to signify when you are finished with the dialog box.

Opening a Program

We will begin our tour of TML BASIC by opening a few example applications on the
TML BASIC disk. TML BASIC is capable of opening up to four separate editing
windows at one time, each independent of the other and containing a different
program. This feature provides you the flexibility of studying the source code of two
or more programs at the same time, or even copying code from one program to use
in another. Chapter 4 discusses the different techniques for copying source code
from one program to use in another.

We will start by opening the TML BASIC Open File Dialog Box, which lists the files
available on the TML BASIC disk. You can accomplish this by either dragging the
cursor down the File menu and then releasing the cursor on the Open command,
or by typing the Open command-key equivalent Regardless of the method
you use, the result on your screen should appear similar to Figure 2-4.

| e JITY Edit Search Windows Compile ProD0S

Openwhich file:
/Tnl/

3 Icons ] (_Disk )
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1 More Examples
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2 Part3.Examples ( Those )

[ System
( Concel )

Figure 24
Open File Dialog Box

TML BASIC User's Guide 2 Using TML BASIC



The Open File Dialog Box displays the files and folders contained on the TML BASIC
disk. Now, click the mouse on the PART1.EXAMPLES folder once and then on the
Open button. The files contained in the PART1.EXAMPLES folder now appear in the
Open File Dialog Box as illustrated in Figure 2-5. Find the HELLOWORLD.BAS file and
click the cursor over its name and then on the Open button to open the file.

Window

Il

Open which file:
&= /Tnl/Part1Examples/

[ Averoges.Bas ( Disk )
—

[ Dema.Bos

D3 Errors.Bas
Exomplelib.Bas @
Hellnworld.Bus
D) Libdemo Bas
( Concel )

Figure 2-5
PART1.EXAMPLES Folder

If your system is operating from either a hard disk or two disk drive system, click the
mouse on the Open File Dialog Box's Drive button until you find the
PART1.EXAMPLES folder containing the TML BASIC example programs.

Once you have selected the HELLOWORLD.BAS example program, its source code is
read from the disk and placed in a newly created editing window titled
HELLOWORLD.BAS. Now, open a second example program, DEMO.BAS from the
PART1.EXAMPLES folder, using the same technique described above.

Organizing the Editing Environment

Figure 2-6 illustrates both the HELLOWORLD.BAS and DEMO.BAS windows open and
overlapping each other. TML BASIC provides you the ability of arranging your
open windows at any location on the screen so that you can see the source code in
both windows. Organizing windows can be accomplished either by dragging each
window with the mouse or by invoking one of TML BASIC's window commands.
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Figure 2-6
Overlapping (Stacked) Windows

Click once on the HELLOWORLD.BAS window's title bar using the mouse, and drag
the window anywhere on the screen. You should notice when you first click the
mouse on the window it immediately makes HELLOWORLD.BAS the active window,
if the window is not already active, and places it in front of the DEMO.BAS window.
To change the size of an editing window you use the grow box. The grow box is the
small box in the bottom right corner of the editing window which has two small
rectangles in it. Now change the size of the window by clicking the mouse once in
the grow box of the HELLOWORLD.BAS window and dragging the mouse anywhere
on the screen.

Pulling down the Window menu displays TML BASIC's window commands. After
mastering the mouse techniques to change each open window's location, pull-down
the Window menu and select Stack Windows. The result should arrange the
windows similar to when they were originally opened as shown in Figure 2-6.

Now, select the Next Window command and notice how the editor places the
HELLOWORLD.BAS window behind the DEMO.BAS window and makes the DEMO.BAS
window the active window. Finally, selecting Tile Windows results in the two open
windows appearing in a tile format as shown in Figure 2-7. When two or more
windows are opened at one time, placing the windows in a tiled position allows you
to see each program's source code at the same time.
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Figure 2-7
Tiled Windows

Program Integrity

Thus far you have learned how to open editing windows (each containing program
source code) as well as the various techniques for reorganizing windows on TML
BASIC's desktop. TML BASIC makes opening and rearranging windows easy with
its three window commands. TML BASIC also provides you a safe means of
maintaining the integrity of your program's source code in the event an
unintentional change to the program's source code has been made.

The example programs opened in this chapter will be of use again later in this
manual's discussions. Therefore, it is important not to alter their original content.
Choosing the Revert command from the File menu directs TML BASIC to ignore
any changes inadvertently made to a program's source code since it was last saved.
When selecting this command, TML BASIC re-reads the last version of the
program's source code from disk and places it into the editing window, thus
ignoring all changes that have been made to the source code.

The Revert command should be used anytime an unintentional change has
occurred in a program's source code. Remember, every change made to the
program's source code since the last save will be lost as a result of issuing the Revert
command. TML BASIC will display a dialog box asking if you are certain about
discarding the changes made to the program prior to reverting your changes.
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When you close an editing window or quit from TML BASIC, and you have not yet
saved the changes made to a program, TML BASIC will ask if you would like to save
the changes made. At this point you have one last chance to decide if you want to
lose or keep your editing changes, or cancel the Close command altogether.

Exiting TML BASIC

In this chapter, we opened two example programs contained on the working disk,
discussed rearranging windows in the editing environment and defined a means to
avoid having unintentional changes saved in a program's source code.

Before leaving this chapter, you should close all open windows, exit TML BASIC
and turn the computer off just as you would clean-up your desk before leaving for
the day.

To close the open windows, select one window at a time by clicking the mouse
anywhere on an open window and then choose Close from the File menu (clicking
a window's close box accomplishes the same result). If changes were made to either
program's source code, the Close File Dialog Box will appear asking if you would
like to save those changes. Be sure to click the No button, thus ensuring the
original program source code's integrity. After closing both files, select Quit from
the File menu to exit TML BASIC and return to the Finder's desktop.
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Cheplier 3

Compiling and Running a Program

In Chapter 2, several of TML BASIC's file and window commands were discussed.
In this chapter, we will explore the three different compile options available in TML
BASIC allowing you to compile and run programs. To do this, we will re-open the
same two examples discussed in Chapter 2.

Looking at Examples

Begin by booting your Apple IIGS with your TML BASIC disk and then run TML
BASIC by double-clicking on the TML BASIC icon.

The HELLOWORLD.BAS program used in Chapter 2 is a simple input/output (I/O)
program. The program is written to demonstrate how TML BASIC writes the line of
text "Hello World" as output to the screen and then recognizes the carriage return
key from the keyboard as input to the program. The DEMO.BAS example program
uses the same I/O capabilities as HELLOWORLD.BAS but tests various string functions
of TML BASIC.

Before we begin, let's re-open the HELLOWORLD.BAS and DEMO.BAS example
programs. Recall that to open these programs you select the Open command from
the File menu, then open the PART1.EXAMPLES folder and select the appropriate
filenames from the Open File Dialog Box.

After opening both programs, the TML BASIC editing environment will consist of
two open windows containing each program's source code. Figure 2-6, in Chapter 2,
illustrates what your screen should look like as a result of opening both programs.
You may wish to reorganize the two open windows so that both program source
codes are visible - issue the Tile Windows command from the Windows menu.

Compiling Alternatives

TML BASIC offers the programmer three different options for compiling programs.
The compile commands are found in the Compile menu. You can see each of the
commands by pressing and holding the mouse button down over the Compile
menu. Figure 3-1 shows the two open editing windows in a tiled position with the
Compile menu pulled down.
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Figure 3-1
Compile Menu

The first command in this menu is likely to be the one you use most often. The To
Memory & Run command invokes TML BASIC to compile the source code in the
active editing window (the topmost window), and then, upon successful
completion, executes the program directly within the Apple IIGS's internal memory.

The To Disk command is used to invoke TML BASIC to compile a program and
create a stand-alone ProDOS 16 application file on disk. You will use this command
when you have a complete running program free of errors and you wish to execute
the program directly from the Finder.

Finally, the Check Syntax command allows you to quickly verify the syntax of a
TML BASIC program. This option does not run the selected program nor does it
create a disk file. This is the fastest compile option available in TML BASIC.

When a compile option is invoked by selecting any of the three compile commands,
TML BASIC displays the Compile Progress Dialog Box. This dialog is used to display
the compiler's progress during compilation. When the Compile Progress Dialog

Box's indicator bar reaches the right side of the display, the compile process has been
completed.

Testing a Program's Source Code

The Check Syntax command is the fastest of the three compilation techniques
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since it does not cause any code to be generated. Instead, this command instructs
TML BASIC to verify the active program was written using valid BASIC key words,
statements and functions. It cannot, however, check a program for correct logic. For
example, an infinite loop in a program's source code will go undetected by the
Check Syntax command.

Click the mouse once on the HELLOWORLD.BAS window making it the active
window. Pull-down the Compile menu and select the Check Syntax command.
The Compile Progress Dialog Box is immediately displayed indicating the
compiler's progress as it checks the syntax of the source code - Figure 3-2.
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FOR Counter = LENCHessage$) 10 2 STEP -1

PRINT LEFT$(Messages, Counter-1);

PRINT SPCC78-LEN(Nessage$);

PRINT RIGHTS(MESSAGES, LEN(Hessage$ -Counter-1)
NEXT Counter

Figure 3-2
Complle Progress Dialog Box

When the indicator bar inside the Compile Progress Dialog Box reaches the right
side of the display, the compile is complete. As you will see, TML BASIC takes only
a brief moment to compile the HELLOWORLD.BAS program. The reason for this, of
course, is that TML BASIC is a fast compiler. In addition, the program is quite small
and the Check Syntax command is the fastest of the TML BASIC's three compile
options.

A result of no errors found does not necessarily mean a program is completely free

of all possible errors. However, using the Check Syntax command will ensure the
program does not contain any syntax errors.
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It is important you use the Check Syntax command when you are uncertain
whether your program will run correctly. Since this command does not run the
program after compiling it, you can avoid situations where your program contains
logic errors which might cause the computer to crash.

If an error is detected in the source code of a program, TML BASIC will stop the
compilation process, return to the TML BASIC editor, highlight the exact location of
the discovered error and then display a descriptive error message. Errors are
discussed later in this chapter in the section "Detecting Program Errors".

Running a Program

Once you have determined your program does not contain any syntax errors by
issuing the Check Syntax command, the program can then be run. To do this,
select the To Memory & Run command from the Compile menu. Upon selecting
this command, TML BASIC again displays the Compile Progress Dialog Box. This
time the compiler generates code for the program. If the program does not contain
syntax errors the compiled program is immediately run.

To run a compiled program, the TML BASIC environment temporarily shuts down
by hiding its menus, windows, etc. and then transfers control to the compiled
program. The compiled program is now in complete control of the computer as it
executes. When the program has completed execution, the TML BASIC
environment restores its menus and windows allowing you to continue
programming.

Because it is possible the compiled program may contain logic errors causing the
machine to crash, TML BASIC provides a safety feature called Auto Save. If this
option is turned on, TML BASIC automatically saves any changes you have made to
the program's source code prior to compiling. This feature ensures you will not lose
your source code changes in the event of a catastrophic error during your program's
execution. The Auto Save option is discussed in more detail in Chapter 6 under the
"Preferences..." section.

To compile the HELLOWORLD.BAS program, first, be certain the program is in the
active window (topmost window). If it is not, make it the active window by clicking
the mouse once anywhere in its window. Now select the To Memory & Run
compile command. The HELLOWORLD.BAS program uses the text screen to display
the message "Hello World" at several locations on the screen. The program then
waits for the Return key to be pressed. After the Return key is pressed, program
execution terminates and control is returned to the TML BASIC environment with
the windows restored exactly as you left them.
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Creating a Stand-Alone Application

As seen above, the ompile to memory feature of TML BASIC is extremely fast and
interactive. However, there exist one small problem — you must launch TML
BASIC every time you want to run a TML BASIC program. Thus, the third
compilation technique available in TML BASIC — To Disk. This compile option
allows you to create stand-alone ProDOS 16 applications that can be run from the
Apple IIGS Finder by double-clicking on its icon just as you did the TML BASIC icon
to invoke TML BASIC. You can even copy the compiled application to another disk
and run it from there because TML BASIC is no longer required after the program is
compiled to disk.

Let's compile the HELLOWORLD.BAS program to disk. Make the open window
containing the HELLOWORLD.BAS program the active window (remember the
compile commands only work on the active window). Select the To Disk command
from the Compile menu to compile the HELLOWORLD.BAS program and create a
stand-alone application on disk. You will notice the compilation process takes
significantly longer to complete this time.

The reason for this additional amount of time results from the compiled program
being written to disk. The name of the resulting application file on disk is
HELLOWORLD, and it is located in the same folder as the HELLOWORLD.BAS source
code file.

IMPORTANT

Following are the three rules used by TML BASIC to determine a compiled
application's filename when issuing the To Disk compile command.

(1)  If the name of a source code file ends with the suffix .BAS then the
application file is assigned the same name as the source code file less the
.BAS suffix. The application file is placed in the same directory as the
source code file.

(2)  If the name of a source code file does not end with the suffix .BAS then
the name of the application file is the name of the source code file with
the letters "APP" added to the end of the name. If the source code
filename is greater than 12 characters, TML BASIC uses only the first 12
characters of the source filename. The application file is placed in the
same directory as the source code file.

TML BASIC User's Manual 31 Compiling and Running a Program



(3)  If the source code is in a new "Untitled" window, that is, there exist no
disk file containing the new program's source code, then the name of the
application file becomes UNTITLEDAPP. The application file is placed in
the folder currently open when the Open File Dialog Box is displayed.

Compiling Libraries

In addition to compiling programs, TML BASIC is capable of compiling libraries. A
library contains BASIC program statements, but is not capable of being run
(executed) like a program. Instead, a library is compiled separately from a program
and then used in one or more different BASIC programs. Libraries allow you to
split a program up into smaller, more manageable pieces of code. Chapters 7 and 8
describe libraries in greater detail.

A library looks much like a program except it begins with the statement DEF
LIBRARY and ends with the statement END LIBRARY. The file EXAMPLELIB.BAS in
the PART1.EXAMPLES folder is an example of a TML BASIC library. Additionally, the
file LIBDEMO.BAS within the PART1.EXAMPLES folder shows how the EXAMPLELIB.BAS
library's source code is used in a program. Using TML BASIC, you should open
these two files to see how the library mechanism is used in TML BASIC.

The EXAMPLELIB.BAS file is a library containing a procedure declaration that prints
the message "Hello World" just like the HELLOWORLD.BAS program. The
LIBDEMO.BAS file is a program which has only four lines of code. However, when
this program is run, it generates the same output as the HELLOWORLD.BAS program
because it calls the procedure in the EXAMPLELIB.BAS library.

Because a library is not capable of being run, the TML BASIC compiler acts
differently when selecting the various compiler commands in the Compile menu.
As mentioned above, when a library is compiled, it does not create a program that
can be run. However, TML BASIC does save the library's compiled code so that
other programs can use it. Thus, when selecting the To Memory & Run command,
TML BASIC compiles the library but then returns control to the editor instead of
transfering control to the compiled code as it would do for a program. Note that
TML BASIC does save the compiled code in memory so that it can later be used by a
program. To experiment, compile the EXAMPLELIB.BAS file by selecting the To
Memory & Run command. Then compile the LIBDEMO.BAS program using To
Memory & Run as well. Because the LIBDEMO.BAS file is a program, it is run
immediately after successfull compilation

Libraries can also be compiled using the To Disk command. When a library is

compiled to disk, it does not create a ProDOS 16 application, but rather, a TML
BASIC .LIB file. The .LIB file contains the library's compiled source code. When a
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program needs to use a library that has not been compiled to memory using the To
Memory & Run command, TML BASIC searches for the compiled code on disk in a
.LIB file. Try compiling the EXAMPLELIB.BAS file using the To Disk command and
then look on the disk using the Apple IIGS Finder for its .LIB file.

IMPORTANT

Following are the rules used by TML BASIC to determine a compiled library's
filename when issuing the To Disk compile command.

(1)  TML BASIC uses the name of the library as specified in the DEF
LIBRARY statement as the base name of the compiled library file. TML
BASIC then adds the suffix .LIB to the end of the library name to create
the complete filename. The library file is placed in the same directory as
the source code file.

The source code filename has no effect on the name of the compiled
library file. However, to avoid confusion, it is recommended that the
source code filename be the same as the library name with the .BAS
suffix.

(2)  If the library name is greater than 12 characters, TML BASIC uses only
the first 12 characters of the library name. The .LIB suffix is then added,
and the file is created in the same directory as the source code file.

The Check Syntax command behaves exactly the same for both programs and
libraries. That is, TML BASIC only verfies the library's source code contains legal
BASIC statements.

Detecting Errors

So far in this chapter we have discussed how to compile programs using TML
BASIC. However, our discussion has been limited to programs known to be correct,
that is, they do not contain any errors. In this section, we will discover how TML
BASIC deals with errors.

First, let's consider the components of the TML BASIC environment. TML BASIC
is an integrated development tool made up of three separate pieces — the editor, the
compiler and the linker. These different pieces work so closely together the user
really only perceives them as one in the same. However, knowing how these pieces
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work together will help you understand the error messages TML BASIC reports to
you.

The editor of course, is where you spend most of your time. It is responsible for the
editing windows and most of the commands available in each TML BASIC menu.
The compiler is invoked whenever you select any of the three compile commands.
The compiler is responsible for checking if syntax errors exist in your program and
then generating code for the program. Finally, the linker component of TML BASIC
is only invoked when you have chosen to compile a program to memory or to disk.
The linker is responsible for combining the compiled code with other pieces of code
your program needs (i.e. libraries). It is also responsible for allocating the internal
memory a program requires in order to run within the Apple IIGS's memory, and
for writing a compiled program to disk.

The editor only reports errors related to the editing environment. It will report an
error when you ask it to find a string in a program that does not exist, when there is
not enough memory to read another program into memory, and other operations
related to the editing environment. The compiler only reports errors related to
illegal BASIC source code. If you misspell a reserved word or forget to put a comma
where one was expected, the compiler reports an error. Finally, the linker reports
errors when an attempt to create a final program fails. This might happen if you
compile a program to disk and the disk is locked or there is not enough room to fit
the compiled program on disk.

When any component of the TML BASIC environment detects an error it first takes
whatever actions necessary to recover without causing any loss of data and then
displays the Error Dialog Box with a descriptive error message. In addition to the
error message, an icon on the left side of the dialog box is also displayed. This icon is
used to indicate which component of TML BASIC detected the error. The icon can
usually help you better understand the error message. In addition, if the error is
related to a particular part of your program's source code, the editor displays that
portion of source code in the editing window and highlights the exact location of the
error. Highlighting usually occurs for detected compiler errors.

Editor Errors

To study how error messages are reported in the TML BASIC environment, first,
close any open editing windows, and then open the file ERRORS.BAS from the
PART1.EXAMPLES folder. We have intentionally placed several errors in the source
code of this program so that you can see how the TML BASIC error reporting
mechanism works.

The first type of error we will explore is an editor error. To cause an editor error
select the Find What command from the Search menu (we will discuss this feature
in greater detail in Chapter 4, but for now just follow along). The Find Dialog Box
appears asking you to enter the text you wish to find. At this point, enter the string
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"XYZ" without the double quotes, and then click the mouse on the Find button.

The string "XYZ" does not appear in the file ERRORS.BAS, so the editor reports this in
the Error Dialog Box as seen below in Figure 3-3.

o Fil[dit Search LAILILEY Compile ProD0S

& "¥YZ* not found

Errors.Bos
REM This exanple contains syntax and runtine errors

| Nessage$ = “This is an exanple progran’
| PRINT LEFT$(Message$ 18) ‘This statenenl is nissing a coma

| i = 15000 A

jh = 20008

Yok =ikt R 'This statenent causes an Overflon Error
RINT "The sun of "5 ifs " and °j j& " is "} sunk

Figure 3-3
Error Dialog Box - Editor Error

Note the icon displayed in the left side of the Error Dialog Box. This icon indicates
at the error was detected by the editor. To make the Error Dialog Box go away,
simply click the mouse button or press any key on the keyboard. The editor detects
and reports several different types of errors. For a complete list of the errors
reported by the editor see Appendix A.

Compiler Errors

The ERRORS.BAS program also contains a syntax error in its source code - an illegal
statement. To find this error simply select the Check Syntax command from the
Compile menu. Figure 3-4 shows how the compiler reports syntax errors.

In this example, the message " ',' expected" is reported in the Error Dialog Box. This
time a different icon appears — a small green bug. This icon indicates the error was
detected by the compiler. In addition, the editor highlights the exact source code
location of the encountered error in black, thus enabling you to fix the problem.
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& File Edit Searchmtmpile ProD0S

% " " expected.

B 5 e R 0 R R R R 5 5 A e e - B
Errors.Bos
REM This exanple contains syntax and runtine errors

Heseaged = “This is an exaaple progran’
PRINT LEFT$(Messages [B) 'This stalenent is nissing a conng

4 if = 15000
3 j% = 20008
sunf = if + jR 'This statenent causes an Overflon Error
FRINT “The sun of *; i%; " ond " jA; " is °) sund

Figure 34
Error Dialog Box - Compiler Error

Again, click the mouse to make the Error Dialog Box go away and then enter the
comma symbol where the compiler expected it. After correcting the syntax error,
again select the Check Syntax command from the Compile menu. This time the
compiler does not report any errors.

Do not compile this program using the To Memory & Run command yet, since
there is another type of error we will discuss below.

Linker Errors

The final component of TML BASIC is the Linker. There exist only a few errors
which the Linker can detect. One of these errors arises when the Linker attempts to
write a program which has been compiled to disk, and an error occurs when writing
to the disk. This error can occur when the disk is full or it has been write protected.

If you would like to see how the linker reports an error message, remove the floppy
disk which contains the ERRORS.BAS source code file and write protect it. Then place
the disk back in the disk drive and select the To Disk command from the Compile
menu. After the Compiler successfully compiles the program it invokes the Linker
to the program and attempts to write the stand-alone application file to disk.
However, you have write protected the disk. Thus, the linker displays the error
message seen in Figure 3-5. The icon used by Linker errors is two small chain links.
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Errors.Bas
FEN This exomple contains syntax and runtine errors

Hessage$ = “This is an exanple progran”
PRINT LEFT$(HessageS, 18) "This statenent is nissing a conma

if = 15000
j# = 20000 Y

sud = ik + jR 'This statenent causes an Overflon Error
PRINT “The sun of *j i%; " and °j jA; " is " suaf

BETS Keys

Figure 3-5
Error Dialog Box - Linker Error

Runtime Errors

Actually, you might think of TML BASIC as having a fourth component — your
program. When your program runs, it too can generate errors. For example, the
program might attempt to add two numbers which cause an Overflow Error, or
provide a value out of range thus causing an Illegal Quantity Error. These errors are
called runtime errors. The built-in TML BASIC debugger is capable of detecting
runtime errors and reporting them back to the TML BASIC environment so that
you can modify your program accordingly.

The TML BASIC debugger is available for debugging your programs only if you
choose the To Memory & Run command from the Compile menu. In addition,
you must instruct TML BASIC to turn on the debugger and generate the special
debugging code needed to detect runtime errors by selecting the Debug option from
the Preferences Dialog. The Preferences Dialog is displayed by choosing the
Preferences... command from the Compile menu. The Preferences Dialog is
discussed in detail in Chapter 6.

When you turn on the debugger by choosing the Debug option from the Preferences
Dialog, the Compiler generates special code everywhere an error might potentially
occur. Please note while this feature provides a powerful mechanism for
developing programs, it does generate a significant amount making your programs
larger and slower. After you have a program working correctly, it is generally a good
idea to turn this option off.
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Finally, the program ERRORS.BAS also contains a runtime error. To see how this
feature works, make sure the the Debug option is turned on (it is on by default) in
the Preferences Dialog, then select the To Memory & Run command from the
Compile menu. If you successfully removed the syntax error in this program as
described in the "Compiler Errors" section of this chapter, the compiler and linker
should complete successfully. The TML BASIC environment then temporarily
shuts down by hiding its menus and windows and runs the compiled program.

Unfortunately, this program has a runtime error in the seventh line. In this line,
the value of sum% is set equal to the sum of the variables i% and j% (15,000 +
20,000). Because the variable sum% in an integer variable, the largest value it can
store is 32,767. Thus, the value 35,000 overflows the capacity of sum%. The TML
BASIC debugger detects this and aborts the execution of the running program.
Upon returning to the TML BASIC environment, the line in which the error was
detected is highlighted and the runtime error message "Overflow Error" is displayed
in the Error Dialog Box as seen in Figure 3-6. In this example, the bomb icon is
displayed to indicate the error is a runtime error.

The range and precision of numbers in TML BASIC is discussed in Chapter 7. In
addition, each TML BASIC statement and function described in Chapter 10 lists the
runtime errors that may possibly occur for each statement and function respectively.

v

;;5_ﬁ “"agé‘n}“”",w Compile ProD0S

a Overflow error. A

' Errors.Bas
3 REN This exanple contains syntax and runtine errors

Nessage$ = “This is an exanple progran”
| PRINT LEFT$(Message§, 18) ‘This statenent is missing a conna

| if = 15009
| i = 20009

| RIW "The sun of “j ify "ond °y jAy " is "y sund

| GETS Keys

Figure 3-6
Error Dialog Box - Runtime Error
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There are numerous errors that can occur when your program is running.
Appendix A outlines each of these, along with a brief description of how each error
might occur.

Just a Reminder...

In the course of editing, compiling, running programs and fixing errors, you may
forget the last error that was detected and reported in the Error Dialog Box. If this
happens, don't despair, it is possible to recall the Error Dialog Box to display the last
error encountered. To do this, simply select the Last Error command in the
Windows menu.

Finally, recall that all editor, compiler, linker and runtime errors are listed in
Appendix A of this manual. Along with each error is a description of the error and
usually some suggestions of how the error might have occurred and how to fix it.

As always, before leaving this chapter, be certain to close all open windows without

saving any changes to the files you might have made. To leave TML BASIC select
the Quit command from the File menu.
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Chepier 4
Advanced Program Editing

In Chapters 2 and 3, the principles of opening, closing, compiling and running
programs were discussed. In this chapter, several additional TML BASIC features
are introduced demonstrating TML BASIC's powerful editing commands.
Additionally, the techniques for printing a file is discussed, and finally, you will
learn about three ProDOS commands which may be issued from within TML
BASIC.

Creating a New Editing Window

e Ffile Edit Search Windows Compile ProD0S
. Helloworld.Bas

PRINT * Kello Horld® *
PRINT * Hello Horld"
PRINT * Hello Horld"

PRINT * Hello Horld"

PRINT * Kello Horld"
PRINT * Hello Horld"
PRINT * Hello Horld"

e
[ il

(]

Figure 4-1
Tiled Windows

Once again, boot your Apple IIGS using the working copy of TML BASIC and launch
TML BASIC. Set-up your editing environment by first opening the
HELLOWORLD.BAS example program and then selecting the New command from the
File menu. Complete the set-up process by selecting the Tile Windows command
from the Windows menu. Figure 4-1 illustrates the resulting screen's appearance
after setting up your working environment.

TML BASIC User's Guide 4] Advanced Program Editing



Rather than using an example program alone to describe each of the edit features
available to you in TML BASIC, we will create a new program using the empty
window you just created. The result will be a complete program written entirely by
borrowing source code from the HELLOWORLD.BAS example program.

Using the Clipboard

TML BASIC implements an editing feature called the clipboard. The clipboard is a
temporary storage area for text and is used to store words, lines or entire portions of
a program's source code. The fundamental idea of the clipboard allows you to
borrow text from an existing program's source code for use in a different location
within the same program or to use in an entirely different program.

TML BASIC allows you to place portions of text into the clipboard by using any one
of its editing commands - cut, copy, paste, clear and select all - found in the Edit
menu and discussed in the sections ahead. Prior to issuing any one of these four
commands, the range of text to be placed in the clipboard must first be selected.
Three methods are available to you when selecting text - dragging, shift-clicking and
double-clicking. One method may be more appropriate than the other two
depending upon the range of text to be selected.

Before discussing the three different means of selecting text, we will define the
current insertion point. The current insertion point is located where the cursor
appears after clicking the mouse once in the active window. Using the location of -
the current insertion point you can begin entering or deleting characters, or you can
use the location for marking the beginning of text to be selected.

Dragging is the easiest way to select text, and can be accomplished by moving the
cursor on the screen to the beginning of the text you wish to select, then click and
hold the mouse button down while dragging the cursor to the end of the text to be
selected. You will notice the range of selected text appears in black (inverted) type.
Dragging allows you to be extremely particular about the range of text you select.

Secondly, you can select a range of text by shift-clicking. To shift-click, move the
cursor to the beginning of the text you wish to select and click the mouse once.
Next, move the cursar to the end of the text you wish to select, then hold down the
Shift Key and click the mouse button once to select all of the text between the first
and second mouse clicks. This method is best used to select a large portion of a
program's source code for placement in the clipboard.

Thirdly, to select text by double-clicking, position the mouse over the text you would
like to select, and quickly press the mouse button twice. Double-clicking will select
the entire word which appears under the cursor. Double-clicking is most useful
when only a single word is to be placed in the clipboard.
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Editing Commands

At the heart of TML BASIC is its ability to assist you in writing programs. Unlike
conventional editors, TML BASIC provides a full-screen editing environment
enabling you to both write programs more quickly and make necessary source code
changes with little difficulty.

With HELLOWORLD.BAS selected as the active window, issue the Select All command
from the Edit menu. Notice that the entire contents of the HELLOWORLD.BAS
window is inverted and placed in black type. Remember, inverted text represents
the range of selected text. Now, issue the Copy command from the Edit menu.
You will not see any changes on the screen, but rest assured the selected range of text
now exists in TML BASIC's clipboard and may be used to assist in creating a new
program.

Position the cursor anywhere in the "Untitled" window and click the mouse once,
resulting in the "Untitled” window becoming the active window. Now, move the
cursor to the first line in the "Untitled" window and click the mouse once to create
the current insertion point. Issuing the Paste command from the Edit menu at this
time results in the clipboard's present contents being pasted into the "Untitled"
editing window beginning at the current insertion point. Figure 4-2 illustrates the
result of performing this Select All/Copy/Paste command.

e File Edit Search Windows Compile ProDOS
Helloworld.Bas

PRINT * Hello World"
PRINT * Hello Horld"
PRINT * Hello Norld®
PRINT * Hello Horld"
PRINT Hellg Horld"
PRINT " Hello Horld"
PRINT *

Untitled,
PRINT * Hello Horld™ ®
PRINT * Hello World"

PRINT "Press any key to continue..."
BETS Key$

Figure 4-2
Pasting Source Code
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Unlike the Copy command, the Cut command results in the selected range of text
being completely removed from its original location in a program's source code and
placed into the clipboard for use elsewhere by issuing the Paste command. If you
had issued the Cut command in place of the Copy command in the last example,
the HELLOWORLD.BAS editing window would appear empty with its entire contents
placed in TML BASIC's clipboard.

That brings to mind one last editing command - the Clear command. Issuing the
Clear command after selecting a program's entire range of text results in the active
window's contents being erased. The program's source code is not placed in the
clipboard and you would have to issue the File menu's Revert command in order
to restore the program's source code. The Clear command is useful when you do
wish to erase a selected range of text or an entire window's text and without
disturbing the clipboard's contents.

Obviously, TML BASIC's editing commands are not limited to selecting an entire
program's source code. Using any one of the three techniques discussed in the
previous section for selecting text (dragging, shift-clicking and double clicking)
enables you to cut, copy, paste and/or clear any range of text within a program.

Note that the clipboard can only hold one piece of information at a time, so
everytime you cut or copy from a window, any information previously in the
clipboard is replaced. Each time you paste from the clipboard, however, a duplicate
copy of the information remains in the clipboard.

Find and Change

After pasting the HELLOWORLD.BAS program's entire source code into the "Untitled"
window, the next step in our exercise is to change each occurrence of the character
string "Hello World" to "First Attempt" in the "Untitled" window. One way to do
this, of course, would be to move the cursor to the end of the each occurrence of the
string "Hello World", and then backspace over each "Hello World" string and
re-type "First Attempt". This could be an extremely cumbersome and time
consuming task, so let's investigate TML BASIC's ability of finding a string of text
and replacing it with another string of text.

The TML BASIC Search menu contains three commands for locating and changing
text in an active window. The first command is the What to Find... menu item.
Choosing this command displays the TML BASIC Find Dialog Box shown in Figure
4-3. The Find Dialog Box request two entries be made — Find What and Change To ,
and three buttons — Find, Cancel and Change All.
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o File Edit JOTI0Y Vindows Compile ProD0S
Hol lowarld Ras

Find What: [HelloWorld |
Change To: [First Attenpt |

( rinde ) [ Concel ] [lChungeMl]

T RETTO ROTTY
= I

Untitled
PRINT " Hello Horld®
PRINT * Hello Norld"

PRINT "Press any key to continue,.,”
GETS Key$

Figure 4-3
Find Dialog Box

The Find What item is where the string to be searched for is specified. For our
example, you should enter the string "Hello World" here. If all you wanted to do
was find the next occurrence of this string then you would press the Find button in
the Find Dialog Box. The dialog would go away, and TML BASIC would search the
program contained in the active window, beginning at the current insertion point
for the next occurrence of "Hello World". However, in our example, you also need
to change the string "Hello World" to "First Attempt" once it is found. Thus, you
should enter the string "First Attempt" in the Change To text edit item, and then-
press the Find button.

After pressing the Find button, the string "Hello World" is found, and is
automatically selected by inverting the string in black. To change the string to "First
Attempt”, as you specified in the Find Dialog Box's Change To text edit item, simply
issue the Change then Find command from the Search menu. After changing the
string, TML BASIC proceeds to find the next occurrence of "Hello World". Once
every occurrence of the "Hello World" string has been changed using this method,
TML BASIC reports that the string cannot be found in an Error Dialog Box.

Also, you could save yourself the time of locating and changing each occurrence of
the "Hello World" string by pressing the Change All button in the Find Dialog Box.

One final change you should make is to save the program to disk under the new

name of FIRSTATTEMP.BAS. Selecting the Save As command from the File menu
results in the Sa<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>